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ABSTRACT 
Counting migrating fish in rivers using sonar relies on carefully positioning the transducer to maximize fish 
detection.  A side-looking sonar used to ensonify adult salmon (Oncorhynchus spp.) is typically deployed nearshore 
with the beam directed perpendicular to the current along the river bottom.  Relying on reflections from the river 
bottom or targets to aim the transducer may result in an aim that poorly detects fish.  A better method is to profile 
the river bottom, model the sonar beam in relation to the river bottom contours, and select a tilt angle that places the 
sonar beam along the river bottom across the desired sampling range.  We devised an aiming protocol using river 
bottom profiles obtained from dual-frequency identification sonars (DIDSONs) at several Alaskan rivers.  The 
DIDSONs were deployed nearshore with the multiple beams positioned vertically in the water column and aimed 
cross-river.  Our profiling methods worked well at sites with a linear bottom or a steep to flat slope change but were 
limited when the secondary slope was steeper.  The accuracy of DIDSON profiles was improved by using small 
range windows, centering the bottom image in the beam, and marking the top edge of the bottom image.  We 
selected optimum transducer tilt angles based on the river bottom’s topography and size of the sonar beam. The 
aiming protocol increased our confidence in fish counts obtained using side-looking sonars. 

Key words: river bottom profiles, dual-frequency identification sonar, DIDSON, aiming protocol, side-looking 
sonar, profiles, transducer tilt angle, fish counting, Oncorhynchus, salmon 

 

INTRODUCTION 
When side-looking sonar systems are deployed in rivers for the purpose of counting adult 
migrating salmon (Oncorhynchus spp.), one of the most critical components for obtaining good 
detection is selecting an aim that aligns the beam along the slope of the river bottom.  Migrating 
salmon tend to swim along the river bottom to take advantage of the reduced flow velocities 
(Brett 1995; Hinch and Rand 2000; Hughes 2004; Webb 1995).  Riverine sonar sites are 
typically selected to meet the criteria of a single channel, linear river bottom, laminar flow, fine 
substrate materials, and adequate current flow to prevent fish from milling or traveling offshore 
(Mesiar et al. 1990).  Fish have been counted with sonar systems ranging from single-beam 
echocounters (Bendix counters1) to more modern split-beam and multi-beam sonars (Brazil 
2007; Faulkner and Maxwell 2008; Gaudet 1990; Mesiar et al. 1990; Miller et al. 2007; 
Trevorrow 1997; Westerman and Willette 2007; Xie et al. 2005). 

The alignment of the sonar beam with the river bottom is important regardless of the type of 
sonar used.  For single and split-beam systems, a narrow beam must fit between the river’s 
surface and bottom boundaries.  At sites where fish are bottom-oriented (typical of rivers with 
strong current flows), it is critical that the beam is positioned directly above the river bottom but 
below the surface.  Using narrow-beam, split-beam systems, we have observed substantial losses 
in fish detection with the beam aimed even 1/2° too high above the river bottom.  With multi-
beam sonars, excess energy from the wider vertical beam can often be aimed down into the river 
bottom without altering fish detection rates.  The wider beam is less sensitive to small changes in 
the tilt angle of the transducer.  The Alaska Department of Fish and Game (ADF&G) operates 
several sonar sites in rivers to estimate migrating salmon populations, primarily sockeye salmon 
(O. nerka).  Inseason daily estimates of salmon passage are used in the management of several 
commercial fisheries.  At the sites described in this study, either Bendix counters (single-beam, 
echo-counting sonars; Gaudet 1990) or DIDSONs (Dual-frequency IDentification SONars; 
Belcher et al. 2002) are used to estimate salmon passage rates for commercial fisheries 
management.  The DIDSON is still in the transition phase at some of these sites but will soon 
                                                 
1  Product names used in this report are included for scientific completeness, but do not constitute a product endorsement. 

 1



 

replace the aging Bendix counter (Brazil 2007; Faulkner and Maxwell 2008; Westerman and 
Willette 2007).  We developed a methodology, an aiming protocol, for accurately aligning the 
DIDSON sonar beam with the river bottom using river bottom profiles obtained from DIDSONs 
and absolute tilt information from pitch and roll sensors. 

Aiming a transducer for the purpose of ensonifying migrating fish often depends on interpreting 
information from received echoes visually displayed on oscilloscopes and/or echograms.  With 
no other information available, it is easy to assume that this method is adequate.  For the Bendix 
counter, an aim is typically selected by tilting the transducer up or down until voltage spikes 
received and displayed on an oscilloscope from the river bottom are below the threshold and 
flattened across the sampling range.  This is the ideal circumstance.  Normally, high amplitude 
echoes from bottom obstructions require the sonar technician to raise the beam to avoid 
generating ‘false’ counts.  Once an aim is selected, it is tested by dragging a target through the 
beam at close range and observing the returning voltage spikes on an oscilloscope.  For split-
beam and multi-beam sonars, technicians often select a tilt angle based on observing echoes or 
images reflected from artificial targets and/or the river bottom.  These methods can be deceptive.  
In certain situations, we have measured larger amplitudes from target echoes when the transducer 
was tilted at an extreme downward angle where multiple bounces of the beam were possible 
compared to an angle where the echoes returned along a single path.  Testing the aim with targets 
at close range creates the tendency to tilt the transducer too far down (Maxwell and Smith 2007).  
Positioning targets at multiple ranges to fully test the aim is difficult in rivers under the best 
conditions and is made more difficult by swift currents, ice floes, and floating debris.  Trying to 
keep a target stationary long enough in the beam to separate it from non-target reflections is 
often challenging.  Using the DIDSON profiling method, the information needed to select an 
optimal transducer tilt angle, can be obtained from nearshore, without the use of a boat. 

The DIDSON is a high-resolution, multi-beam imaging sonar with acoustic lenses designed to 
focus the returning energy and sharpen the resulting video-like images (Belcher et al. 2002).  The 
DIDSON field of view is 29° with a 14° vertical beam.  For fish counting, the multiple narrow 
beams are positioned horizontally showing the river bottom as a mostly static background with 
fish moving across (Figure 1; sample fish images can be viewed at 
http://www.soundmetrics.com).  Positioning the narrow beams vertically, rather than 
horizontally, provides detailed information in the vertical dimension that can be used to image 
the river bottom’s profile (Figure 2).  This level of detail is not available from traditional 
bathymetry methods.  River bottom profiles obtained from the DIDSON compared well with 
profiles generated from actual range and depth measures or other bathymetry methods (Maxwell 
and Smith 2007).  The error in DIDSON profiles comes from a combination of horizontal and 
vertical beam spreading and the manual marking of targets.  The calculated depth of the river 
bottom from DIDSON images depends on which beam the image is observed in, not its position 
in the beam.  This limits the accuracy of the calculation to one-half the beam spacing.  However, 
Maxwell and Smith (2007) observed that the error was less than the potential beam-spreading 
error would suggest.  In certain situations, the river bottom topography limits the use of a 
DIDSON for creating profiles.  A slope change in the cross-river direction from flat nearshore to 
steep offshore creates shadow zones where returning echoes are either not able to reach the 
transducer or require multiple bounces to reach it.  Under these circumstances, an accurate 
profile cannot be created.  However, the bottom images can be assessed, and because fish-
counting sonars have this same limitation, the profiles can be used to determine that a new site be 
selected. 
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To determine the optimal sampling aim for our fish-counting sonars, we recorded river bottom 
images using the DIDSON, and extracted range and depth points allowing us to create a river 
bottom profile.  A rotateable sonar beam was overlaid onto the profile and used to determine the 
optimal tilt angle for the fish-counting sonar. 

 

OBJECTIVES 
Our primary study objectives were to: 

1. Describe the river bottom profile at each sonar site. 

2. Identify environmental features, i.e. turbidity, bottom structure, water depth, that may 
reduce fish detection. 

3. Select the optimal transducer tilt angle for each site based on information from the river 
bottom profiles. 

4. Develop an aiming protocol using the DIDSON profiling methods that can be used by 
sonar technicians. 

 

METHODS 
STUDY SITES  
We profiled the river bottom at ADF&G sonar sites along the Copper, Kasilof, Kenai, Nushagak, 
and Yentna Rivers (Figure 3).  The Copper River sonar site is approximately 100 m downriver of 
the Million Dollar Bridge below the outlet of Miles Lake.  At this site, the river is one main 
channel approximately 360 m wide and is influenced by Childs Glacier downriver and Miles 
Glacier upriver.  The natural substrate on the south bank is made up of large cobble and 
boulders.  A concrete substrate (30 m long, 5 m wide, 13% grade) was constructed in 2001 to 
provide a uniform bottom to aim the sonar beam along.  On the north bank, the sonar was 
deployed on the natural substrate of sand and small cobble.  From 1991 to 1995, the U.S. 
Geological Survey measured suspended sediment levels at the Million Dollar Bridge with a 
range of 0.5–2.2 kg/m3 with corresponding discharges of 1,119–10,394 m3/s (Brabets 1997).  In 
2002, turbidity measures off the south bank exceeded the 1,000 Nephelometric Turbidity Units 
(NTUs) maximum limit of a Global Water turbidity meter (Maxwell and Gove 2004). 

The Kasilof River sonar site is located 12.6 km (7.8 mi) from the river mouth.  At this site, the 
river is a single channel approximately 58 m wide and the bottom substrate is a mixture of large 
cobble and boulders.  Water level gradually rises through the summer.  The turbidity, measured 
with a secchi disk, is typically < 0.46 m. 

The Kenai River sonar site is located 30.6 km (19 mi) from the river mouth.  At this site, the 
river is a single channel approximately 120 m wide.  The bottom substrate is a mixture of cobble 
with occasional boulders.  Water level gradually rises through the summer peaking in late July or 
early August.  Turbidity measured at this site in 2002 was 21 NTUs along the north bank and 28 
NTUs along the south bank (Maxwell and Gove 2004). 
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The Nushagak River sonar site is located approximately 40 km upriver from the terminus of the 
Nushagak commercial fishing district and 4 km downriver from the village of Portage Creek.  
Located within tidal influence, the main river channel is approximately 300 m wide at the study 
area.  During high tide, a reduction in current occurs but no flow reversal.  Overall, the water 
level drops as the season progresses.  The bottom substrate is mostly sand and fine gravel.  The 
turbidity level was not measured at this site, but at times, the water is clear enough to see fish 
swimming in the shallow water near the banks.   

The Yentna River sonar site is located 9.7 km (6 mi) from the river mouth.  At this site, the river 
is a single channel approximately 250 m wide.  The water level fluctuates throughout the 
summer.  The bottom substrate is a mixture of gravel and cobble.  The turbidity, measured with a 
secchi disk, is typically 0.10-0.12 m. 

DATA COLLECTION  
Standard and long-range DIDSONs were used to record river bottom profiles at the sonar sites. 
The specifications for each DIDSON by frequency are listed in Table 1.  A Hydroacoustics 
Technology Inc. (HTI) Model 661H single-axis rotator or a Remote Ocean System (ROS) dual-
axis rotator with remote controller and relative feedback was used to adjust the position of the 
DIDSON transducer.  We used H-shaped mounts made from aluminum poles held together with 
slightly larger diameter aluminum poles welded into T-shapes (Figure 2).  The rotator was 
attached to a hanging bracket on the mount, and the transducer was affixed in the vertical 
configuration to a metal plate mounted to the rotator.  Although many sonar systems are coupled 
with automated rotators that include feedback, the feedback is only relative.  At some of the 
sites, the DIDSONs were modified to include an internal attitude sensor.  Where an internal 
sensor was not available, a BioSonics, Jasco, or Geomechanics attitude sensor was attached and 
aligned with the angle of the transducer.  Each sensor was calibrated with a bubble level on shore 
to obtain a zero attitude point.  The sensor provided absolute tilt and heading information in one-
second intervals.   

At the Copper River south bank site, a DIDSON was deployed on the concrete substrate.  At all 
other sites, DIDSONs were deployed on the natural substrate.  Each DIDSON was deployed at a 
fixed location nearshore and aimed perpendicular to the river current with the multiple beams 
positioned vertically.  The transducer was tilted so that the river bottom within the range of 
interest appeared in the beam’s center.  To ensure the best range resolution for each recorded 
image, a profile was compiled from a series of images.  We recorded short range images using a 
more downward transducer aim and raised the aim successively higher to record farther ranges.  
The DIDSONs display threshold was set as low as possible without distorting the raw image, and 
the intensity was adjusted to provide the best contrast.  The number of recorded frames per 
second was set as high as the incoming signal from the ethernet would allow without losing 
frames.  Focus and receiver gain were automatically set.  We measured the water temperature 
and the transducer’s water depth and distance to shore.  Sound speed was calculated from the 
water temperature based on equations from Simmonds and MacLennan (2005) and entered into 
the DIDSON initialization file to obtain correct range measures.  For each new aim, we recorded 
the transducer’s tilt angle and lens depth (distance from the river surface to the center of the 
lens).  All site measurements are included in Appendix A1.   

Error in DIDSON profiles comes from the increasing diameter of the individual beams in the 
vertical and horizontal planes as they spread out from the transducer, and user error from 

 4



 

marking the profiles.  Both sources of error were addressed by Maxwell and Smith (2007).  
Marking error and beam spreading error were minimized by marking the brightest region 
(highest amplitude) on the image.  Echoes within this region should be closest to the beam 
centers.  

DATA ANALYSES 
Converting the river bottom images into range and depth values was accomplished within the 
DIDSON software using the ‘Mark Depth Profile’ function.  To use this function, points along 
the edge of the bottom image were marked by the user, and the depth (D) of each selected point 
was calculated based on the following equation, which is diagrammed in Figure 4: 

]
180

)sin[( πθ •• ++= trsD      (1) 

where: 

s = distance from the center of the lens to the river surface (m); 

r = range from the center of the composite beam’s two-dimensional view-field to the 
target (m); 

 t = tilt angle of the transducer (degrees); and 

θ = angle from the central axis of the composite beam’s two-dimensional view-field to        

     the target (degrees). 
 

Range measures were based on echo-return time and the sound speed, which was calculated 
using water temperatures measured at each site (Simmonds and MacLennan 2005).   

The extracted range and depth polar coordinates were converted to rectangular coordinates and 
plotted in Microsoft Excel with a model of the DIDSON beam overlaid.  Placement of the model 
beam was based on the distance to shore, lens depth, and water depth at the DIDSON transducer 
positioned horizontally for fish counting.  The vertical angle of the model beam was 14º for all 
sites except the Kenai River’s north bank where a concentrating lens narrowed the DIDSON’s 
nominal beam angle to approximately 8º.  We extended the model beam to the desired sampling 
range and used Excel macros to control the tilt angle.  We selected the tilt angle that best aligned 
the beam with the river bottom throughout the sampling range and positioned the central axis of 
the beam just above the river bottom.  Small changes were allowed to the selected aim to reduce 
interference from the surface and bottom boundaries.   

At a few of the sites, we tested the final aim with an artificial target, a 10.16 cm plastic sphere 
filled with 4.4 mm copper-plated steel shot (bb’s).  Acoustically, the target was roughly the size 
of a sockeye salmon (-32 dB; Smith and Maxwell 2007).  The target was lowered to the river 
bottom approximately 2 m from the transducer and raised to the surface to test the detection 
limits at close range.  Ideally, target work should be performed at multiple ranges; however, this 
was difficult at most of our sites.  

Appendix A2 contains an aiming protocol designed to be used by technicians that outlines the 
process of generating river bottom images from the DIDSON, and processing the images to 
determine the optimal transducer tilt angle for the sampling sonar system.  A sample form for 
recording the measurements is included in Appendix A3.   
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RESULTS 
River bottom profiles were generated along both banks of the Copper, Kasilof, Kenai, Nushagak, 
and Yentna Rivers across multiple field seasons.  A transducer aim was selected that aligned the 
sampling sonar beam with the river bottom and placed the beam’s maximum energy (the beam 
center) where the majority of adult salmon migrate.  The optimal transducer tilt angles selected 
for each site are listed in Table 2.  

COPPER RIVER 
At the Copper River, bottom profiles were recorded throughout the field season as the water 
level rose, and the transducers were moved inshore.   

Off the south bank, five DIDSON profiles were combined to create an overall profile of the 
concrete substrate and the river bottom beyond (Figure 5).  On May 11, the long-range DIDSON 
was deployed near the offshore edge of the substrate where the detection range extended to 63 m.  
When deployed at the substrate end, the standard DIDSONs high-frequency profile image 
showed an initial, smooth 4-m segment followed by an intermittent rocky region (Figure 6).  The 
smooth segment was likely part of the ice shelf that the DIDSON was deployed on, since the 
actual substrate did not extend that far offshore.  In each successive profile, a standard DIDSON 
was positioned farther up the substrate, and the ice shelf was no longer present.  The image 
profiles were straight and smooth along the concrete substrate.  Bottom images from the standard 
DIDSON were limited in range to approximately 19 m, except the July 10 image, which had a 
maximum range of only 13 m.  The plastic sphere target, deployed 2 m from the face of the 
transducer to test the aim, was visible on the river bottom. 

Off the north bank, the long-range DIDSON profiles from 2004–2007 showed a gradually 
decreasing slope out to approximately 67 m (Figure 7).  The May 19 image, recorded when the 
water level was lowest, had a range of only 16 m.  On June 6, after the DIDSON was moved 
inshore following increases in water level, the river bottom was visible out to 32 m.  The 
maximum visible range of a bottom profile was 40 m.  The combined bottom profiles from all 
four years were similar out to 20 m.  Beyond 20 m, the 2006 and 2007 slopes began to drop off 
more steeply.   

KASILOF RIVER 
At the Kasilof River, a standard DIDSON was used to record bottom images of the north bank 
site in 2005 and both banks in 2007.   

The DIDSON images from the north bank showed a flat, gradual slope out to 12 m (Figure 8).  
The bottom signal then became weak or absent out to 17 m, which indicated a change to a 
nonreflective substrate or a depression.  A dip in the bottom occurred at 22 m.  The north bank 
had a narrow water column and a fairly linear slope which required a transducer tilt angle close 
to level when the beam was aimed. 

The south bank DIDSON images showed a flat, gradual slope out to 20 m with weak bottom 
signal from 10-17 m (Figure 9).  The linear, flat south bank slope was similar to the north bank, 
but the water column was narrower.  Strong surface reflections required the beam center to be 
aimed into the river bottom.  Target tests were not performed.  
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KENAI RIVER 
In 2004, a long-range DIDSON was used to record river bottom images of the sites along both 
banks of the Kenai River.  From 2005-2007, a long-range DIDSON was used on the north bank 
and a standard DIDSON on the south bank.   

The north bank DIDSON images showed a linear river bottom with a smooth slope out to 31 m 
and a second slightly steeper slope out to 90 m (Figure 10).  The shallow slope and narrow water 
column required a transducer tilt angle close to level.   

Off the steeper south bank, high-frequency bottom images from the standard DIDSON indicated 
a rockier bottom at this site.  A ridge, most likely created from a large boulder, rose 0.2 m off the 
river bottom at 8 m (Figure 11).  The river bottom dropped steeply out to 9 m, flattened and 
remained fairly smooth out to 55 m, and gradually rose beyond.  During all years, the river 
bottom was visible at the maximum range setting.  In 2004, the 78-m profile showed an increase 
in slope beyond the thalweg.  The 2007 profile was shallower from 15-29 m compared to profiles 
from previous years.  A transducer tilt angle was used that optimized sampling of the initial, 
nearshore slope.  In Figure 12, north and south bank DIDSON profiles were combined to show a 
cross section of the river with the DIDSON beams overlaid.  With the selected aims, the plastic 
sphere target was visible along the river bottom nearshore and at several ranges offshore.  

NUSHAGAK RIVER   
River bottom images were recorded using a long-range DIDSON off the Nushagak River’s right 
bank site (facing downriver; north bank) from 2005–2007 and a standard DIDSON off the left 
bank from 2004–2007.   

Off the right bank, the profiles dropped steeply out to 10 m, then flattened to a gradual slope that 
continued to the 70 m end range (Figure 13).  The length of the initial slope was dependent on 
water level.  As the field season progressed and the water level dropped, this segment shortened.  
Close to shore, the river bottom had rough, highly reflective features except between 7-10 m 
where areas of absent bottom indicated a weak signal return.  The selected transducer tilt angle 
raised the central portion of the beam higher off the bottom which allowed for a longer range on 
the secondary offshore slope.  The sonar deployment location changed in 2007 to a site 
approximately 50 m downriver, closer to the sonar tent.  The slope at the new site was less steep 
with a more gradual slope decline in the nearshore region (Figure 14).  The river bottom profile 
showed a shallower water column throughout the ensonified range and a flatter overall slope.  
The bottom image was visible out to 76 m.  The DIDSON sampling beam covered the majority 
of the water column out to the end range.   

Off the left bank, the slope gradually declined out to the maximum viewing range (40 m) in the 
2005 profile (Figure 15).  In 2006 and 2007, the profile changed and the slope began to flatten 
from 10 m out to the end range.  No obstructions or weak signal returns from the bottom were 
observed.  The target was detected nearshore on both banks along the river bottom. 

YENTNA RIVER 
The Yentna River bottom images were recorded using a standard DIDSON from 2005-2007.  No 
distinguishing rocks or depressions were observed in the profiles.   
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The steep slope along the north bank was fairly consistent out to 15 m then flattened (Figure 16).  
The bottom slope dropped 2 m in depth from the transducer to 7 m offshore.   

Off the south bank, the smooth linear slope dropped steeply (2.5 m) out to 10 m then became less 
steep (Figure 17).  The selected tilt angle optimized the sampling of the nearshore slope, while 
limiting the effective range of the secondary slope.  Target tests were not performed. 

 

DISCUSSION 
The DIDSON-based profiling method allowed us to observe the effects of aim changes on the 
relationship between the transducer beam and the river bottom and surface.  In many cases, 
because of the DIDSON’s wide vertical beam, it was not possible to place the maximum energy 
(center axis) of the beam near the river bottom.   At sites where the water column was narrow, it 
was often necessary to push the central axis of the beam into the static river bottom to avoid 
interference with the river’s surface.  The deeper water columns at the Kenai and Copper River 
south banks and both sides of the Yentna Rivers allowed us to place the central axis of the beam 
just above the river bottom.  The entire beam fit within the confines of the river boundary layers.  
At the shallow water sites of the Kenai River north bank, and the Kasilof River, much of the 
excess DIDSON beam energy was aimed into the river bottom.  The optimal aim at these 
shallow water sites was close to level, with selected aims ranging from -1° to -1.5°.  The south 
bank profile of the Kasilof River, although relatively flat, required that the beam be aimed 
further into the river bottom because of strong surface reflections.  At these shallow sites, the 
DIDSON beam covers the entire water column from river bottom to surface.  We would expect 
few or no fish to pass undetected over the beam at these sites.  Conversely, the Yentna River had 
the steepest slopes, with selected aims of -13° and -16.2°.  Here, there was more opportunity for 
fish to pass over the beam if conditions caused them to rise up off the river bottom and into the 
top portion of the water column.   

At the Copper River site, high turbidity levels limited the range of the sonar.  Compared to the 
other rivers profiled, the Copper River was the most turbid.  Higher turbidity levels occurred in 
July, when the water was high, and the current was stronger.  At the start of the field season, in 
May, we used a long-range DIDSON to profile the south bank because the lower frequency 
allowed a longer detection range.  As is typical that time of year, the water level was at the lower 
edge of the concrete substrate, and we were able to generate a profile that extended as far beyond 
the substrate as possible.  The river bottom at the offshore end of the substrate is gradually 
eroding.  In Figure 6, a DIDSON image shows a 1-m wide hole just beyond the base of the 
substrate.  It is unknown whether fish swim into this hole and pass by undetected during the early 
season when the water level is low.  The north bank river bottom may have undergone 
significant changes starting in 2003.  The Million Dollar Bridge was undergoing repairs from 
2003 until the end of June 2005 to raise a collapsed span on the north bank.  The repair project 
included building a work pad in the river around the bridge abutment just upriver from the north 
bank sonar site.  The work pad created a large back eddy that extended downriver and 
significantly changed the flow pattern redirecting the current offshore.  The work was completed; 
however, remnants of the pad remain, and the current is slowly degrading it.  Before the pad was 
put into place, it was assumed the majority of salmon traveled close to shore.  With the altered 
flow pattern, fish may have been pushed further offshore, beyond the range of the sonar. Early in 
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the season, the sampling range was limited by the slope change; later, turbidity was the primary 
limiting factor. 

At the Kasilof River south bank site, surface noise required aiming the beam into the static river 
bottom.  Along the north bank, the beam was aligned along the river bottom.  On this side of the 
river, the water was slightly deeper, and the surface intensity was weaker.  Both sides of the 
Kasilof River might benefit from a narrower vertical beam that would better fit the water 
column.  Fish detection was not affected by turbidity or a change in slope on either side of the 
river. 

Along the Kenai River south bank, the steep to flat slope change has little effect on the 
DIDSON’s ability to detect fish; however, the Bendix counter’s range was limited to 7 m by this 
slope change.  During the winter of 2007, flooding occurred on the Kenai River along with major 
ice jams.  These events may have caused fill to occur in the offshore area of the south bank site; 
seen in the comparison of the 2007 profile to subsequent years (Figure 11).  The north bank 
profile changes from a relatively flat to slightly steeper slope.  This topography may create an 
unreliable profile.  The change in slope is small; however, echoes from the river bottom along 
the secondary slope may be a mixture of direct and multi-path reflections.  The shallow depth 
along this bank makes it easier for multi-path reflections off the surface to be detected by the 
transducer.  Offshore fish detection may also be affected.  

The Nushagak River bottom is dynamic and changes may have occurred between the years when 
the DIDSON profiles were created, which could account for some of the differences between the 
Nushagak’s left bank DIDSON profiles.  The turbidity is much less compared to the other rivers, 
and does not limit the range on either side of the river in this study.   

The Yentna River profiles were very similar among years.  Both banks are relatively similar to 
each other, with a steeply dropping slope nearshore, which flattens offshore.  Fish detection 
could be affected by the steep slopes on both banks.  The transducer’s tilt angle creates an area in 
the upper portion of the water column that is not ensonified where possible fish may go 
undetected. 

The accuracy of the DIDSON profiles can be improved by using small range windows, centering 
the bottom image in the beam, and marking along the top edge of the bottom image (Maxwell 
and Smith 2007).  Because the range resolution on the screen depends on the number of pixels 
available to create the image, smaller range windows result in more accurate images.  To keep 
the range windows small, we recorded multiple bottom images at each site by increasing both the 
start ranges and window lengths.  Range and depth points from the multiple images were then 
combined to form a single profile plot.  Tilting the transducer until the bottom image is centered 
within the DIDSON viewing window will also result in a more accurate profile.  The source 
level of the individual beams is highest in the center beam, and considerably lower on the outer 
beams (pers. comm., Ed Belcher, President Sound Metrics Inc.)  When the DIDSON’s narrow 
beams are positioned vertically, the 14o horizontal beam can widen the bottom image.  The width 
of the bottom image depends on the upriver-downriver slope of the river bottom.  Steeper slopes 
in this dimension create wider bottom images.  For consistency, we only marked points along the 
top edge of the bottom image.  The DIDSON vendors have developed a condensing lens that 
narrows the 14° beam to 1°.  This should improve the accuracy of the bottom image in these 
situations.   
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Previously, bathymetry maps were created to assist in aiming the transducer but were only 
updated when funding allowed.  Consequently, annual changes in the bottom slope went 
undocumented.  Because of the ease of creating DIDSON profiles at sites where the DIDSON is 
used for sampling, annual profiling of the river bottom makes it possible to track trends and 
events that may alter the topography of the river bottom.  Profiles should be recorded at the 
Copper River north bank site every year to examine changes in the river bottom from the gradual 
deterioration of the work pad at the bridge upriver.  Along the end of the south bank concrete 
substrate, annual profiling is needed to monitor the scour occurring and detect potential ice 
shelves early in the season.  At the Nushagak River, the bottom is fairly dynamic and annual 
profiles are advised.  The Kasilof, Kenai, and Yentna River sites have more stable river bottoms; 
however, following a flood event, winter ice jams, or other potential bottom-changing events, 
updated profiles are essential.  When developing a new site for sonar deployment, DIDSON 
images of the river bottom can assist in plotting an accurate profile, determining whether the 
bottom slope is adequate for sonar deployment, determining range limitations for sampling fish 
passage, and finding the best aim at a particular location.  
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Table 1.–Dual-frequency identification sonar (DIDSON) specifications. 

DIDSON      
model 

Frequency 
(MHz) 

Number of 
beams 

Beam dimensions 
(°) 

Beam spacing 
(°) 

Maximum range 
(m) 

Standard 1.8 96 0.3x14 0.3   12 

Standard 1.1 48 0.4x14 0.6   40 

Long-range 1.2 48 0.5x14 0.6   40 

Long-range 0.7 48 0.8x14 0.6 100 

 

 

 

 

 
Table 2.–Optimal transducer tilt angles and sampling ranges selected after evaluating the DIDSON 

river bottom profiles at ADF&G sonar sites. 

River/Bank Vertical Beam angle (°) Tilt angle (°) Sampling range (m) 
Copper River    

    North Bank 14 -5.6 35 

    South Bank 14 -8.2 20 

Kasilof River    

    North Bank 14 -1.5 30 

    South Bank 14 -4.0 30 

Kenai River    

    North Bank 8 -1.0 50 

    South Bank 14 -7.0 30 

Nushagak River    

    Right Bank (2005-06) 14 -6.2 50 

    Right Bank (2007) 14 -3.5 50 

    Left Bank 14 -5.4 30 

Yentna River    

    North Bank 14 -13.0 30 

    South Bank 14 -16.2 30 

 14



 

 

fish

flow

 

15 

Figure 1.–The DIDSON positioned horizontally on an aluminum H-mount (left) for counting fish and a DIDSON image (right) 
showing migrating fish and bottom reflections along the Kenai River’s south bank. 
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Figure 2.–The DIDSON positioned vertically on an aluminum H-mount (left) to record river bottom profiles and a DIDSON image (right) of 
the river bottom along the Kenai River’s south bank sonar site. 
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Figure 3.–The location of Alaska Department of Fish and Game sonar sites in Southcentral Alaska notated with a square 

and labeled with the name of the river. 
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Figure 4.–A diagram of the depth calculation used by the DIDSON software in the Mark Depth Profile function where: t = 
tilt angle of the transducer (degrees), θ = angle from the central axis of the composite beam’s two-dimensional view-field to 
the target (degrees), and s = distance from the center of the lens to the river surface (m). 
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Figure 5.–Copper River south bank profiles created from DIDSON images of the concrete substrate and river bottom.  Four standard 
DIDSON profiles and one long-range DIDSON profile from different positions along the substrate were combined to create an overall 
profile of the bottom.  The transducer’s position during each recorded profile is indicated by a black square.  A 14° DIDSON beam is 
overlaid and angled 8.2° below level. 
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Figure 6.–Copper River south bank’s concrete substrate displayed in DIDSON images.  On May 11, an ice shelf was visible in 
the first 4 m of the image and a rough, rocky region farther offshore.  On July 10, the range was limited to 13 m during a period of 
high water and increased turbidity. 
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Figure 7.–Copper River north bank’s river bottom displayed in DIDSON images (top) and the resulting profiles (bottom) 
overlaid with a 14° DIDSON beam angled 5.6° below level. 
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Figure 8.–Kasilof River north bank’s river bottom displayed in DIDSON images (top) showing weak or absent echoes from 12-17 m 
(top, right).  River bottom profiles (bottom) are overlaid with a 14° DIDSON beam angled 1.5° below level.   
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Figure 9.–Kasilof River south bank’s river bottom displayed in DIDSON images (top) showing a rocky, uneven bottom and a distinct 
surface line (top, left) and weak or absent echoes from 10-17 m (top, right).  The river bottom profile (bottom) is overlaid with a 14° 
DIDSON beam angled 4.0° below level. 
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Figure 10.–Kenai River north bank’s river bottom displayed in DIDSON images (top), and the resulting profiles (bottom) overlaid 
with an 8° DIDSON beam angled 1.0° below level.   
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Figure 11.–Kenai River south bank’s river bottom displayed in DIDSON images (top) showing a ridge at 8 m (top, left), and a distinct 
surface line across the range (top, right).  The resulting profiles (bottom) are overlaid with a 14° DIDSON beam angled 7.0° below level. 
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Figure 12.–A cross-river profile of the Kenai River with the DIDSON beams used for fish sampling overlaid. The  north bank profile (left) is 
overlaid with an 8° DIDSON beam angled 1.0° below level. The south bank profile (right) is overlaid with a 14° DIDSON beam angled 7.0° 
below level. 
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Figure 13.–Nushagak River right bank’s river bottom displayed in DIDSON images (top), and the resulting profiles (bottom) 
overlaid with a 14° DIDSON beam angled 6.2° below level.   
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Figure 14.–Nushagak River right bank’s bottom displayed in DIDSON images (top), and the resulting profile (bottom) overlaid 
with a 14° DIDSON beam angled 3.5° below level.   
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Figure 15.–Nushagak River left bank’s river bottom displayed in DIDSON images (top), and the resulting profiles overlaid with a 
14° DIDSON beam angled 5.4° below level.   
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Figure 16.–Yentna River north bank’s river bottom displayed in DIDSON images (top), and the resulting profiles (bottom) overlaid 
with a 14° DIDSON beam angled 13.0° below level.   
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Figure 17.–Yentna River south bank’s river bottom displayed in DIDSON images (top), and the resulting profiles (bottom) overlaid 

with a 14° DIDSON beam angled 16.2° below level. 
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Appendix A1.–DIDSON files and associated measurements used to generate river bottom profiles at ADF&G sonar sites. 

Filename (date_time) 
DIDSON 

model Frequency 
Lens depth

(cm)
Tilt angle

(o)
Depth at transducer

(cm)
Water temp.

(oC)
Sound speed

(m/s)
Window length

(m)
Copper River South Bank 
2005-05-11_104815 Long-Range High 30.9 -18.9 59.7 5.7 1429 1-5
2005-05-11_105130  High 29.6 -11.7 59.7 5.7 1429 1-10
2005-05-11_105644  High 29.6 -11.7 59.7 5.7 1429 1-20
2005-05-11_110035  Low 29.6 -11.7 59.7 5.7 1429 3-40
2005-05-11_182142 Standard High 23.8 -13.8 50.8 5.7 1429 1-5
2005-05-11_182250  High 23.8 -13.8 50.8 5.7 1429 1-10
2005-05-11_182450  Low 25.1 -11.1 50.8 5.7 1429 1-19
2005-05-11_182533  Low 25.1 -11.1 50.8 5.7 1429 1-40
2005-05-25_114044 Standard High 23.8 -12.9 63.5 5.7 1429 1-5
2005-05-25_114044  High 23.8 -12.9 63.5 5.7 1429 1-10
2005-05-25_114115  Low 23.8 -12.9 63.5 5.7 1429 1-40
2005-06-13_134003 Standard High 25.1 -11.3 50.8 9.0 1443 1-5
2005-06-13_13400333  High 25.1 -11.3 50.8 9.0 1443 1-10
2005-06-13_134022  Low 25.1 -11.3 50.8 9.0 1443 1-20
2005-07-10_144228 Standard Low 34.0 -10.2 63.5 9.0 1443 1-20
Copper River North Bank 
2004-07-27_192928 Long-Range High 21.0 -7.0 ND 12.0 1455 1-10
2004-07-27_192928  High 21.0 -7.0 ND 12.0 1455 1-20
2004-07-27_193213  Low 21.0 -7.0 ND 12.0 1455 20-60
2005-05-12_154352 Long-Range High 22.2 -4.7 57.2 7.2 1436 1-10
2005-05-12_154857  High 22.2 -4.7 57.2 7.2 1436 1-20
2005-05-12_155129  Low 21.6 -1.6 57.2 7.2 1436 1-40
2005-06-01_111730 Long-Range High 29.9 -6.6 33.0 7.2 1436 1-10
2005-06-01_112139  Low 28.9 -5.6 33.0 7.2 1436 1-20
2005-06-01_112139  Low 28.9 -5.6 33.0 7.2 1436 1-40
2005-06-12_153458 Long-Range High 21.0 -6.6 63.5 7.2 1436 1-10
2005-06-19_113916 Long-Range High 29.9 -9.7 63.5 7.2 1436 1-10
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Filename (date_time) 
DIDSON 

model Frequency 
Lens depth

(cm)
Tilt angle

(o)
Depth at transducer

(cm)
Water temp.

(oC)
Sound speed

(m/s)
Window length

(m)
Copper River North Bank 
2005-06-19_114240  Low 28.6 -7.2 63.5 7.2 1436 1-40
2006-05-11_161536 Long-Range High 17.2 -5.3 59.7 1.1 1408 1-5
2006-05-11_161606  High 17.2 -5.3 59.7 1.1 1408 1-10
2006-05-11_161659  High 17.2 -5.3 59.7 1.1 1408 1-20
2006-06-05_141624 Long-Range High 14.6 -9.4 58.4 5.5 1428 1-10
2006-06-05_141649  Low 14.6 -9.4 58.4 5.5 1428 1-40
2006-06-16_140947 Long-Range High 17.2 -8.0 58.4 5.5 1428 1-10
2006-06-16_140957  High 17.2 -8.0 58.4 5.5 1428 1-20
2007-05-19_161629 Long-Range High 13.3 -3.7 47.3 1.8 1411 1-5
2007-05-19_161716  High 13.3 -3.7 47.3 1.8 1411 1-10
2007-05-19_161737  High 13.3 -3.7 47.3 1.8 1411 1-20
Copper River North Bank 
2007-06-06_153601 Long-Range High 14.7 -6.6 45.7 6.1 1431 1-5
2007-06-06_153621  High 14.7 -6.6 45.7 6.1 1431 1-10
2007-06-06_153639  High 14.7 -6.6 45.7 6.1 1431 1-20
2007-06-06_153659  Low 14.7 -6.6 45.7 6.1 1431 1-40
2007-06-22_115223 Long-Range High 11.8 -8.1 42.4 8.3 1440 1-5
2007-06-22_115242  High 11.8 -8.1 42.4 8.3 1440 1-10
2007-06-22_115259  High 11.8 -8.1 42.4 8.3 1440 1-20
2007-06-22_115320  Low 11.8 -8.1 42.4 8.3 1440 1-40
Kasilof River North Bank 
2005-06-27_130229 Standard High 42.5 -8.3 97.0 14.1 1463 1-10
2005-06-27_130455  Low 41.5 -6.3 97.0 14.1 1463 1-20
2005-06-27_130541  Low 41.5 -6.3 97.0 14.1 1463 10-30
2007-06-19_125650 Standard High 30.5 -3.8 58.4 11.0 1451 1-5
2007-06-19_125711  High 30.5 -3.8 58.4 11.0 1451 1-10
2007-06-19_125813  Low 30.5 -3.8 58.4 11.0 1451 1-40
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Filename (date_time) 
DIDSON 

model Frequency 
Lens depth

(cm)
Tilt angle

(o)
Depth at transducer

(cm)
Water temp.

(oC)
Sound speed

(m/s)
Window length

(m)
Kasilof River South Bank 
2007-06-19_143303 Standard High 12.7 -4.4 43.2 11.0 1451 1-5
2007-06-19_143323  High 12.7 -4.4 43.2 11.0 1451 1-10
2007-06-19_143339  Low 12.7 -4.4 43.2 11.0 1451 1-20
Kenai River North Bank 
2004-08-10_103818 Long-Range High 42.2 -3.3 81.3 11.1 1452 1-20
2004-08-10_103959  Low 42.2 -3.3 81.3 11.1 1452 8-48
2005-06-30_110707 Long-Range High 29.7 -0.3 72.5 16.7 1472 1-10
2005-06-30_110753  High 29.7 -0.3 72.5 16.7 1472 1-20
2005-06-30_110818  Low 29.7 -0.3 72.5 16.7 1472 10-50
2005-06-30_110841  Low 29.7 -0.3 72.5 16.7 1472 10-90
2006-06-29_092458 Long-Range High 42.5 -2.4 71.1 9.1 1444 1-5
2006-06-29_092526  High 45.5 -2.4 71.1 9.1 1444 1-10
2006-06-29_092632  High 42.5 -2.4 71.1 9.1 1444 1-20
2006-06-29_092710  Low 42.5 -2.4 71.1 9.1 1444 10-50
2007-06-29_130209 Long-Range High 21.6 -3.9 57.8 8.6 1442 1-10
2007-06-29_130209  High 21.6 -3.9 57.8 8.6 1442 1-20
Kenai River South Bank 
2004-08-20_121500 Long-Range High 23.7 -15.8 73.3 11.1 1452 1-10 
2004-08-20_121929  Low 21.8 -4.6 73.3 11.1 1452 1-40 
2004-08-20_122244  Low 21.2 -2.4 73.3 11.1 1452 1-80 
2005-06-29_115609 Standard High 42.8 -12.5 78.7 16.7 1472 1-5 
2005-06-29_120038  Low 40.0 -2.1 78.7 16.7 1472 5-25 
2005-06-29_120112  Low 40.0 -2.1 78.7 16.7 1472 10-30 
Kenai River South Bank 
2006-06-27_093819 Standard High 45.5 -20.0 76.2 9.1 1441 1-5
2006-06-27_094000  High 43.8 -16.6 76.2 9.1 1441 1-10
2006-06-27_094144  Low 42.6 -11.6 76.2 9.1 1441 1-20
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Filename (date_time) 
DIDSON 

model Frequency 
Lens depth

(cm)
Tilt angle

(o)
Depth at transducer

(cm)
Water temp.

(oC)
Sound speed

(m/s)
Window length

(m)
Kenai River South Bank 
2007-07-09_191500 Standard High 45.7 -6.0 68.6 10.2 1448 1-10
2007-07-09_190000  Low 45.7 -6.0 68.6 10.2 1448 1-30
Nushagak River Right Bank 
2005-06-08_194203 Long-Range High 29.3 -10.9 56.5 13.9 1462 1-10
2005-06-09_150431 Long-Range High 20.4 -6.0 61.6 13.9 1462 1-20
2005-06-09_150646  Low 19.9 -4.7 61.6 13.9 1462 1-40
2005-06-09_151009  Low 19.2 -1.2 61.6 13.9 1462 20-100
2006-06-06_203147 Long-Range High 17.8 -14.8 43.2 nd nd 1-10
2006-06-06_203355  High 17.2 -10.1 43.2 nd nd 1-20
2006-06-06_203541  Low 15.9 -6.0 43.2 nd nd 1-40
2006-06-06_203651  Low 15.9 -6.0 43.2 nd nd 10-90
2007-06-04* Long-Range High 15.7 -11.1 40.6 10.3 1449 1-10
2007-06-04  High 15.7 -11.1 40.6 10.3 1449 1-20
2007-06-04  Low 14.5 -8.0 40.6 10.3 1449 1-40
2007-06-04  Low 14.5 -8.0 40.6 10.3 1449 1-80
Nushagak River Left Bank 
2004-07-16_122123 Standard High 89.5 -13.0 106.7 17.0 1473 1-5
2004-07-16_122123  High 89.5 -13.0 106.7 17.0 1473 1-9
2004-07-16_122322  Low 89.5 -13.0 106.7 17.0 1473 1-18
2005-06-07_155941 Standard High 17.8 -9.0 57.5 13.9 1462 1-10
2005-06-07_160005  Low 17.8 -9.0 57.5 13.9 1462 1-20
2005-06-07_160023  Low 17.8 -9.0 57.5 13.9 1462 1-40
2006-06-07_162211 Standard High 51.8 -12.1 90.2 nd nd 1-5
2006-06-07_162527  High 51.8 -10.5 90.2 nd nd 1-10
2006-06-07_162626  Low 51.8 -10.5 90.2 nd nd 10-30
2007-06-04_133450 Standard High 12.7 -6.2 39.4 10.5 1449 1-10
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Filename (date_time) 
DIDSON 

model Frequency 
Lens depth

(cm)
Tilt angle

(o)
Depth at transducer

(cm)
Water temp.

(oC)
Sound speed

(m/s)
Window length

(m)
Nushagak River Left Bank 
2007-06-04_133524  Low 12.7 -6.2 39.4 10.5 1449 1-20
2007-06-04_133655  Low 12.7 -6.2 39.4 10.5 1449 1-40
Yentna River North Bank 
2005-07-13_153217 Standard High 21.0 -21.8 58.0 9.5 1445 1-5
2005-07-13_153424  High 22.0 -15.8 58.0 9.5 1445 1-10
2005-07-13_153730  Low 20.0 -9.8 58.0 9.5 1445 10-30
2006-07-10_213947 Standard High 26.0 -27.5 67.3 12.3 1456 1-10
2006-07-10_214147  Low 27.3 -20.6 67.3 12.3 1456 1-20
2007-07-07_133508 Standard High 16.5 -11.3 45.7 9.0 1443 1-10
2007-07-07_133519  Low 16.5 -11.3 45.7 9.0 1443 1-20
Yentna River South Bank 
2005-07-12_152009 Standard High 22.0 -20.7 56.0 9.5 1445 0.5-5
2005-07-12_152141  High 21.0 -16.8 56.0 9.5 1445 1-10
2005-07-12_152411  Low 19.5 -9.7 56.0 9.5 1445 1-40
2006-07-10_183840 Standard High 21.6 -28.2 64.8 12.3 1456 0.5-5
2006-07-10_184041  High 21.6 -25.4 64.8 12.3 1456 1-10
2006-07-10_184252  Low 19.7 -21.8 64.8 12.3 1456 1-20
2007-07-07_095950 Standard High 22.9 -18.0 54.6 9.0 1443 1-10
2007-07-07_100004  Low 22.9 -18.0 54.6 9.0 1443 1-20
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*The DIDSON software saved the wrong time in the filename so it was not included.

 



 

Appendix A2.–A side-looking sonar aiming protocol with instructions for generating river bottom 
profiles using a dual-frequency identification sonar (DIDSON). 

 

 
Figure 1.–DIDSON mounted with the multiple beams positioned vertically (left) and a sample river 

bottom image (right).   

 

 

Equipment: 

• DIDSON and accessory equipment  
• Mount and mounting brackets 
• Automated rotator or manual method to tilt the DIDSON 
• Tilt and roll sensor (internal DIDSON sensor or external sensor) 
• Computer 
• Power source and appropriate converters 
• Bubble level, thermometer, tape measure, tools for mounting equipment and hardware 

 

Required Measurements: 

• Water temperature (calculate sound speed in m/s) 
• Water depth at the transducer 
• Water depth from surface to center of transducer lens  
• Transducer tilt angle 
 
 

-continued- 
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Figure 2.–DIDSON set-up using 120 VAC power.  
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Equipment set-up 

1. Attach the automated rotator to the aluminum H-shaped mount in a configuration that 
ensures tilt movement of the transducer.   

2. Set up the DIDSON as shown in the picture, on the mounting plate with the lens 
positioned vertically, and attach to the rotator.  The DIDSON should be mounted ~15-30 
cm from the river bottom.  The DIDSON can be used with a ≤ 200 ft cable connected 
directly to the topside box.  A computer ethernet cable connects the topside box to the 
computer.  If a DIDSON cable longer than 250 ft is needed, connect the 50 ft cable to the 
DIDSON and to the side of the thinnet converter marked Sonar.  Connect the long cable 
to the side of the thinnet converter marked Topside and to the topside box.  A short 
computer ethernet cable plugs into the topside box and links to the ethernet extender.  
Connect a second ethernet cable from the ethernet extender to the computer.  

3. Mount the attitude sensor on the top flat surface of the lens using hose clamps.  Ignore 
this step if you are using a DIDSON with an internal compass. 

4. Calibrate the sensor with a bubble level on shore to obtain a zero attitude point.  Place a 
level on top of the sensor or DIDSON and move the rotator until the sensor is level.  Zero 
it in the sensor program.  If you are using the DIDSON internal compass zero the 
compass in the DIDSON program (Sonar> Configure> Zero Tilt/Roll/Depth Offsets). 

5. Test and record the limits of the rotator while the mount is still onshore.   Rotate slowly 
and record pan and tilt limits that stop the DIDSON with enough space to safely prevent 
encountering the mount.  For the ROS rotator with the computer control, these limits can be 
set in the software.  For other rotators, it is necessary to record the limits in the front of the 
logbook and remind each sonar operator about these limits. 

6. Deploy the sonar with the lens perpendicular to the river’s current.  Push the mount 
offshore until the DIDSON and sensor are submerged.   

7. Open the DIDSON program and turn on the sonar at the topside box.  It may take a 
minute for it to connect (See the Troubleshooting section if there is a problem).   

 
Collecting profiling data 

1. Adjust window settings in the Sonar Controls.  For the best resolution, start with a short 
window length and use the high frequency mode.  Set the Window Start to ~1 m and the 
Window Length to 5 m. 

2. Adjust the tilt of the transducer using the rotator until the river bottom profile (line 
running the length of the image) is in the middle of the viewing window.    

3. Measure the water depth at the transducer, lens depth (center of lens to river surface), 
distance from the transducer to a fixed location on shore, and water temperature in 
Celsius.  For the lens depth, the top of the lens to the surface can be measured and added 
to half of the lens length (total lens length = 6 in).  Calculate the sound speed and enter in 
the Didson.ini File (Edit> Sonar> Didson.ini File; Figure 3).  Make sure all the other 
settings in the file are correct and check Enable Update if changes are being made. 

 
-continued-
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Figure 3.–Example of the DIDSON .ini file located in the DIDSON software where the sonar 

parameters are entered.  

 

4. Input information in the Header ID (Edit> Header ID): river, bank, and 
measurements.  If using an external sensor be sure to add the DIDSON’s tilt angle. 

5. Set the file directory.  Go to File> Set Save Dir/Name and navigate to folder where you 
want to export the data files.  Leave the default name and click Save.  Click NO when the 
‘Replace HHMMSS etc.’ window pops up and YES to the ‘Append Frequency’ (if 
desired).  The files are named with the date, time, and frequency (i.e. 2006-05-
13_130000_LF.ddf). 

6. Record data.  Click on the record button (red circle on toolbar) to start and stop 
recording.  Keep the length of the recording small (5-10 s). 

7. Increase the window length to 10 m and if necessary, adjust the DIDSON’s tilt angle 
and re-measure the lens depth (this distance changes whenever the tilt angle is changed).  
Enter this new information in the Header ID.  Keep extending the window length and 
recording until the bottom profile is no longer visible.  Adjust the tilt angle when 
necessary.  For close ranges, we use the high frequency mode and tilt the DIDSON down 
at a greater angle.  For longer ranges, we use the low frequency mode and raise the 
DIDSON to extend the viewing range.   

8. Write in the logbook the DIDSON file names and all measurements. 
 

-continued-
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Processing DIDSON profiles 

1. Open a recorded file in the DIDSON program.  Go to File> Open and navigate to the 
first file to process.   

2. Adjust the threshold and intensity settings of the raw image to view the profile as 
clearly as possible.  Make sure the river surface is on the left side of the image.  (You will 
know if the surface is on the left if when tilting the transducer down, the bottom profile 
moves from right to left in the display window)  Click Reverse in the Display Controls if 
it is not. 

3. Check the sound speed in the Sonar Status window to see if it is the same as when the 
file was recorded.  If not, go to Edit> Sonar> Didson.ini File and enter the correct sound 
speed and check the Enable Update box.  Click ‘OK’.  Close out the DIDSON program 
and reopen the file.  (This will save the sound speed information in the DIDSON’s 
initialization file.)   

4. Go to Processing> Special> Mark Depth Profile.  A pop-up box will ask if the river 
surface is on the left side of the image, click OK. 

5. Enter lens depth and tilt.  Lens depth is from mid-lens to the river’s surface.   The tilt is 
entered as a positive value even though it is tilted down.    

6. Mark the profile by using the computer mouse to click along the top edge of the river 
bottom image from the start to end range to create range and depth data points.  To erase 
a mark, click it a second time.  When finished, right-click and a graph of the data points 
will appear. 

7. Export the range and depth points.  Go to Processing> Special> and uncheck Mark 
Depth Profile.  Click Yes you want to save to a text file.  Name the new file with the date 
and hour of the image file and click Save. 

 
Creating a DIDSON Profile 
For this step, obtain a copy of the Excel “Beam Workbook” containing macros that allows the 
user to place a model beam over the river bottom profile and vary the tilt angle (the workbook is 
available from either author).  The directions below are for use with this workbook.  If the 
workbook is not available, the user may create their own by plotting the river bottom profile in a 
range versus depth plot, converting the beam dimensions and transducer position measures to 
rectangular coordinates and plotting the edges, end, and center of the resulting beam.   

1. Copy and paste the data from the text file into the Beam Workbook.  The exported text 
files list the range in the first column and depth in the second column.  To separate the 
data into two columns go to Data> Text to Columns> Delimited> Next> check Comma> 
Next> Finish. 

2. Make the depth values negative. 
3. Plot the range and depth values.  Select the beamchart tab in the workbook, right-click 

on the chart, and select Source Data> Series tab> Add to enter the profile data.  Name the 
profile and select the data for the X (range) and Y (depth) values. Click OK. 

4. Deploy the horizontally-positioned DIDSON in the same location where the profiles 
were recorded. 

-continued-
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5. Measure the distance to shore, the lens depth, and the water depth at the position of the 
transducer. 

6. Add a model DIDSON beam to the plot.  Turn on the beams in the worksheet using the 
colored buttons at the top. 

a. Enter the beam size and desired range.  The DIDSON’s vertical beam width is 
14o.  Enter the desired sampling range in the colored column above the beam you 
selected. 

b. Enter the range (x) and depth (y) of the horizontally-positioned transducer that 
will be used for sampling at the top right of the worksheet.   

c. Tilt the beam using the rotator arrow buttons until a reasonable tilt angle is 
found.  Align the beam center with the region of the river where we suspect most 
fish pass, just above the river bottom.  Use this tilt angle to aim the side-looking 
sonar for fish counting. 

7. Tilt the fish-counting sonar to the tilt angle selected from the beam workbook. 
8. Modify the tilt angle slightly if needed to reduce the occurrence of surface or bottom 

disturbances. 
9. Enter the final aim into the beam workbook to observe the effect of the aim. 
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Figure 4.–River bottom profile created from DIDSON images with a 14° DIDSON model beam. 

Troubleshooting - If the DIDSON is not connecting: 
1.  Make sure the program is not in Demo Mode (Edit>Mode>uncheck Demo). 
2.  When using the 500 ft transducer cable, the Ethernet transfer mode should be in packets 

(Sonar>Configure>Ethernet Transfer Mode>check by Packet Request).  When using a  
≤ 200 ft cable, the transfer mode should be by Frame Request.  

 
-continued-
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3.  Check the parameters and IP address in the .ini file (Edit> Sonar> Didson.ini File).   
4.  Check the IP address on the computer (Control Panel>Network Connections>Local Area 

Connection>Internet Protocol>Properties).  At start-up the computer should obtain it 
automatically or type in 128.95.97.100 for IP & 255.255.255.0 for netmask. 

5.  Close down the program and recycle the topside power.  Reopen the program to see if it 
connects.  Sometimes it is good to completely shut down the computer and start over. 

6.  Check all the connections inside and outside, and reset.   
7.  Plug the video monitor into the topside box and restart the sonar to see if it is booting up.  

This will help narrow down the problem to either the sonar or computer connection.  The 
sonar boot up process will be shown on the monitor along with the IP address it is trying 
to connect to. 
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Appendix A3.–Sample worksheet for recording the information needed to create river bottom profiles 
using a dual-frequency identification sonar (DIDSON). 

 

DIDSON River Bottom Profiling 
Year:                 Model & S/N:        

River:      Bank:      

Location Description:          

 
Filename Depth at 

transducer 
(in)

Lens 
depth 
(in)

Tilt 
angle (o) 

Water 
temp. 
(oC)

Sound 
speed 
(m/s) 

Window 
length (m) 
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